
MS EXCEL 2000-2003 EDITING TIPS AND TRICKS 
 
To Undo an Edit 
There are times when you start to edit a cell and then you want to cancel or undo what you have done.  
If you are still within the cell you can simply hit either the escape key (Esc) or the red X in the formula 
bar.  If you have moved out of the cell you can always undo the action using either the short-cut key 
(Ctrl-Z) or the Undo Icon. 
 

 
 
Copy, Fill and Paste techniques 
Copy 

Quick Copy shortcuts 
Both Ctrl+d and Ctrl+’ copy the above cell’s value into the current cell.  The difference is that 
Ctrl+d copies the formats as well while Ctrl+’ only copies the value. 
 
Copy Formats (Format Painter) 
When you wish to copy the format (e.g. borders, fills, etc.), but not the value, you can use the 
format painter icon.  Clicking the format painter icon once will allow you to copy the format 
ONCE.  If you double-click the format painter icon, you can copy that format multiple times.  The 
format painter will continue to paste the format until you press the escape key on the keyboard 
or click the icon again.    
 
 
Copy Worksheets 
To copy a worksheet you can either use the menu or the right-click method.  This will copy the 
format into a new worksheet.  Please note that formulas that link to other worksheets may not 
work correctly in the copied worksheet. 
 
Menu Method: 
1.  Go to the sheet you wish to copy. 
2.  Edit Menu, Move or Copy Worksheet 
3.  Select workbook if other than the current workbook. 
4.  Select where to place the copy. 
5.  Select the copy option (otherwise the worksheet will just move). 
 
Right-Click Method. 
1.  Right-click on the sheet you wish to copy. 
2.  Select Move or Copy. 
3.  Select workbook if other than the current workbook. 
4.  Select where to place the copy. 
5.  Select the copy option (otherwise the worksheet will just move). 
 



Quick method. 
1.  Select the worksheet you wish to copy. 
2.  Holding down the control key, drag the worksheet to a new position. 
3.  The copy is made and called name(2). 

 
Fill 
In excel you can quickly fill a series of cells with the value of the starting cell by using the fill handle (the 
mouse icon changes to a small black plus sign).  If you select more than one cell to start with, it will copy 
that series of values into the cells you select if they are text.  If you select more than one cell and the 
values are all numeric, then it will continue that numeric sequence.  If you wish to copy and fill the 
numeric sequence, hold down the control key while filling the cells and then the values not the 
sequence will be filled into the cells below. 
 

Starting Values that we will use to fill the columns below. 

 
 
 
Becomes this when filled for each column using the grey areas as the selected cells. 

 
 
Additional options when filling. 
When you are filling cells, Excel automatically fills in the format and the value.  You can be 
allowed a little more lee-way with what is copied if you use the right-click fill option.   

1.  Select the cell(s) to copy. 
2.  Right-click and then drag through the cells you wish to fill. 
3.  When you release the right-click, a pop-up menu will appear. 
4.  In the pop-up menu select how you want to fill the cells 
 Copy cells:  Copies the entire cell like a regular fill. 
 Fill Formats:  Fills in just the format, not the value. 
 Fill Values:  Fills in just the value not the format. 

 
Paste Special Options 
When you copy a value, the simple paste function replaces the cell contents with whatever you copied.  
But there are a number of special paste functions that are available in Excel.    You can paste the entire 
cell (normal paste) or parts of the cell such as the formula, format, value, comments, etc.  You can also 
do a paste that performs a mathematical function with the numerical value that you copied.  And finally 
you can paste the data in a transposed format: that is select a column to copy and paste it as a row. 
 

How to Access Paste Special 
1.  Select and copy a cell value (Ctrl-C or right-click, copy or Edit, Copy). 
2.  Select the cells to paste the information into. 



3.  Access Paste Special: Right-click, Paste Special  or Edit, Paste Special… 
4.  Choose a special paste option(s) from those listed (see below). 
   

    
 
 

Formulas:  You can paste a formula to any new cell or a cell containing information.   Remember 
that you must first select a cell that has a formula.  Formulas can be as simple as =1.1 (note this 
is different than a cell with 1.1 as the value) or complicated which might included functions, cell 
references and constant values.  A straight-forward paste of a formula, copies the formula to the 
new cell and adjusts the references by the distance you moved the cell. 
 

  
  
 
 
 

But you can paste formulas using mathematical functions.  If you select, Formulas and a 
mathematical operation, it will paste the formula into the cell by whatever mathematical 
formula selected (e.g. add/subtract/multiply/divide the value of the formula to the cell). 
 
Example: 

   
   

Copy the formula in F2.  Paste Special it into cells A2:C5, using the Formulas and multiply 
selections. 

 A B C D E 

1 Values Values Values Formula Result Formula 

2 1 1 8 10 =sum(A1:C1) 

3 5 5 5 15 =sum(A2:C2) 



 
 
Notice how it copied the formula as a multiple of the cell value. 

 
Values 
The values paste special option allows the user to paste just the value not the formula or format 
in the cells.  This is best used when you have created a formula to calculate a value but then 
want to delete the values you used to create the formula.  First copy the cell(s) with the formula, 
then paste special in the same cells and select values paste special.  The formulas are now 
replaced with values and you can delete the cells that contributed to the final result in the 
formula with affecting the formula. 

 
Formats 
The formats paste special option allows the user to paste just the format (font type, size and 
color, and cell fill and borders) and not the values. 
 
Operation 
This allows you paste a value using a mathematical operation.  This is best used when trying to 
convert numerical data stored as text to numerical.  Simply multiply all the cells by one using the 
multiply paste special option.  The values stay the same, but they are now text. 
 
Skip Blanks 
This will copy over all the data you selected except when there is a blank (null) cell.  In that case 
the original data will stay instead of becoming blank. 
 

 
 
Transpose data 
The transpose paste special function takes either column or row data and pastes it as a row or 
column, respectively. 
 



 
 
 
Symbols 
Unlike Word or PowerPoint, Excel does not have a quick method to insert a symbol into the spreadsheet 
(there is no symbol choice under the Insert menu).  You can always copy the symbol from Word and 
paste it in the spreadsheet, but you can also use the Character Map accessory that is available on all 
Windows platforms.  To Open the Character Map:  Start Menu, All Programs, Accessories, System Tools, 
Character Map. (Note: since I use this frequently I’ve created a shortcut to it that resides in my Quick 
Launch toolbar).   In the Character Map you can select any symbol available on your PC.  To select a 
character, either double-click or select and click the Select button.  Then you simply go to Excel and 
paste the character.  Also take note in the lower right hand corner the keystrokes needed to recreate 
this symbol without using the character map.  Note that the keystrokes are particular to the Font you 
are in!  These keystrokes will work in any windows program. 
 

 
 
 
Check-Mark 
The check-mark is frequently used in Excel, but searching through the symbols list for the check-mark 
symbol can be time consuming.  A quick way to enter the check mark is to change the font to one of the 
following and use the appropriate letter: 



 
 
Comments 
Frequently when you are creating a spreadsheet you would like to include some metadata that will be 
helpful to either you or another user.  For example you might want to know what fields are summed 
together for a total value, or an explanation for outlier values.  All cells that have a comment have a red 
triangle in the upper right hand corner.  The comment box is typically hidden, and will display when your 
mouse moves over the red triangle.   
 
The default for all comment boxes is a yellow background with the authors name followed by a colon.  
While you cannot change the default settings for the comment box across the board, you can change 
things once you type inside the comment box.  Comment boxes are linked to a cell (they can only be 
linked to one cell) and with an arrow showing which cell they belong to.  Comment boxes are always 
displayed to the right of the cell.  They cannot be moved unless Excel is configured so that the 
comments will always show instead of popping up on a mouse over.  When Excel is configured to always 
show the comments, they can then be moved around the worksheet to other locations.  
 

To make comments always visible: 
1.  Tools, Options… 
2.  On the View tab, under Comments select Comment and Indicator 

 
To change the location of a comment box (only applicable when comments always show): 

1.  Right-click the comment and select Edit Comment or select the comment itself (if 
visible) 
2.  Click and drag the comment box where you desire it. 

 
Printing comments: 
Comments can be printed in two ways: having them visible on the worksheet (not a pop-up) or 
printed at the bottom of the worksheet. 
 
Comment printing options: 

1.  File, Page Setup 
2.  On the Sheet tab, in the Comments drop down box select a style: 

None: no comments displayed 
At end of sheet:  comments displayed at the end of the worksheet; will display 
the comments in the order of the cells as a cell reference, author and then 
comment. 
As displayed on sheet: only visible comments as displayed on the worksheet 

 
 



Freezing and Splitting panes 
Freezing panes allows you to keep selected row and columns visible as you scroll through your 
worksheet.  When you freeze a worksheet, those selected rows and/or columns will not move as you 
scroll through the worksheet.  Freezing only applies to rows to the left and columns at the top.  Freezing 
is good when you want to keep your headers or row labels visible as you are scrolling through a 
worksheet. 
 
Splitting panes allows you to see two parts of the worksheet at the same time.  When a worksheet is 
split it allows you to view and scroll independently in different parts of the worksheet.  Splitting is good 
when you want to copy and paste data between two different areas on a large worksheet. 
 
Note: you can not split and freeze a worksheet at the same time. 
 

Freezing 
1.  Select the row and column where you want the cells to the left and above to stay frozen. 
2.  Windows menu, Freeze Panes. 
3. To unfreeze, select Windows, Unfreeze Panes. 
 
Splitting Method 1 
1.  Place the mouse at the top of the right scroll bar to split the sheet horizontally or at the right 
of the bottom scroll bar to split the sheet vertically (these areas are near the split box).  Notice 
that the cursor will change to a double line with arrows extending each direction. 
2.  Click and drag to the desired width/height.  Scroll within each section as needed. 
3.  Drag back to unsplit. 
 
Splitting Method 2 
1.  Place the cursor in the cell where you want the splits to occur. 
2.  Windows menu, Split. 
3.  To remove split, Windows, Remove Split. 

 
Filter and Sort Options 
Filtering is a quick and easy way to find and work with a subset of data in a list. A filtered list displays 
only the rows that meet the criteria you specify for a column.   If there are many, many unique entries, 
then Excel lists only the first 1,000 unique entries in the drop-down list (there is no way to increase this 
limit).  Unlike sorting, filtering does not rearrange a list. Filtering temporarily hides rows you do not want 
displayed.  There are two filtering methods: Auto Filter and Advance Filter.  Excel depicts filtered data by 
changing the row number to a blue text (normal is black).  Any column with a filter in it has its arrow 
turn to blue instead of black. 
 

Auto Filter 
When you use AutoFilter it applies Filtering arrows to the top row of your spreadsheet.  When 
you click an AutoFilter arrow it displays a list of all the values found in that column.  Select the 
value that you wish to filter by and only those values will appear.  You may select multiple 
criteria (values) from multiple cells but not from the same cell in this method.  To select a 
combination of criteria in a column use the Custom option.   A dialog box appears that allows 
you to choose an expression and criteria (this dialog box allows up to two conditions to be 
defined).   You can use the asterisk (*) as a wildcard character or the question mark (?) to 
represent a single character.  Example, the expression ‘=??t*’ would search for any value that 



has t as the third character regardless of what characters follow it.  If you want to find a value 
that actually contain the question mark or asterisk character then you need to insert a tilde (~) 
before the character.  Remember the difference between ‘And’ and ‘Or’.  And means that both 
criteria must apply, while or means that either criterion must apply.  When evaluating data, 
Microsoft Excel does not distinguish between uppercase and lowercase characters. 
 

 
 
 
The choices of expressions are: 
 

Expression Data Type 

Equals Text and Numeric 

Does not equal Text and Numeric 

Is greater than Numeric 

Is greater than or equal to Numeric 

Is less than Numeric 

Is less than or equal to Numeric 

Begins with Text 

Does not begin with Text 

Ends with Text 

Does not end width Text 

Contains Text 

Does not contain Text 

 
To remove the filter, select All for a value and then no value will be selected for that column.  To 
reset all criteria across the columns, use the Data menu, Filter option Show All. 
 
Filter by Selection 
In order to filter by selection you need to have the AutoFilter icon available in the toolbars.  
Then simply place the cursor in the cell of your selection and click the AutoFilter icon.  Your data 
is now filtered by that selection. 
 
To add the AutoFilter Icon. 
1.  View Menu, Toolbars, Customize… 
2.  Under the Commands tab, select the Data category 
3.  Click and drag the AutoFilter icon up to a toolbar. 



 
Advance Filter Options 
The Advance Filter option allows you to 1) apply multiple criteria to a single column, 2) apply 
multiple criteria to multiple columns or 3) create criteria from a formula.  When an advanced 
filter is applied the AutoFilter drop-down arrows are not visible.  Instead you enter the criteria in 
the criteria range on your worksheet.  By changing the values in this range you change the filter.  
You can place criteria range wherever on the spreadsheet, but it is typically placed before you 
list data.  No matter where it is placed, it must be separated by a blank column from the list you 
are filtering.   
 
Criteria Set Up 
The criteria that you wish to use must have the same column label as in the list.  Criteria are set 
up so that each column is considered an ‘and’ criteria and each row is considered an ‘or’ criteria.  
Enter your criteria in the criteria range. 
 
To Advance Filter 
1.  Set up your criteria range. 
2.  Place the cursor in one of the cells of the list you wish to filter. 
3.  Data menu, Filter, Advance Filter… 
4.  The Advance Filter dialog box appears. 
 

 
5.  Select the action: Filter the list, in-place. 
6.  Enter the List range.  This is automatically assumed by Excel but may be overwritten. 
7.  Enter the Criteria range. 
8.  Click Ok.  You data is now filtered. 

 
 
Sorting 
Excel has two sorting options: Ascending order and descending order and the final sort order is 
dependent on the type of data shown (see table).   Excel uses a character based sort that sorts from left 
to right by each character.  Excel sorts data based on up to three columns (if you want to do more see 
the trick below). 
 
 



Data Type Ascending Sort Order 

Numeric Smallest negative number to largest positive number 

Alpha A to Z 

Alpha Numeric 
(text that includes 
numbers) 

Numeric, punctuation and then alphabetic: 0 1 2 3 4 5 6 7 8 9 (space) ! " # $ 

% & ( ) * , . / : ; ? @ [ \ ] ^ _ ` { | } ~ + < = > A B C D E F G H I J K L M N 

O P Q R S T U V W X Y Z  

  

Logical Values False than True 

Error Values All are equal 

Blanks Blanks are always placed last 

 
Quick Sorts 
If you wish to only sort one column (and do not have related records in adjacent columns) you 
can use the quick sort icons.  To sort, select the entries in the column that you wish to sort.  Click 
the Ascending or Descending sort icon.  This will sort the list.  Remember to not include the 
column label when sorting or it will end up being sorted as well. 
 
Sort by Multiple Rows 
Often you will want to sort by multiple rows and have the information stored in the rows stay 
together.  1.  Select the range you wish to sort. 
2.  Data menu, Sort… 
3.  The Sort dialog box appears.  Select the columns you wish to sort by in the order you wish it 
sorted.  For each item you can choose ascending or descending.  
4.  Check whether your selected range has column labels or not.  If it has column labels, then 
select the Header Row option. 
5. Click Ok. 
 
Sorting by rows instead of columns. 
Follow the same instructions as above, but under the Options, select Orientation and then 
choose Sort left to right.  Your data will now sort within a row instead of within a column. 
 
Trick to sorting by more columns.  If you wish to sort by more than the limited three column 
option from excel there are ways to sort the data in excel, but they require multiple steps.  For 
example if you wished to sort columns in the following order: A, B, C, D, and then E. 
 
1.  First select all five columns and sort by columns C, D and E. 
2.  Select the columns again and now sort by columns A and B. 

Another trick would be to create a column that has all the information you want in it and 

to sort by that column instead.  You would insert a new column and enter a formula to 

concatenate the information together (e.g. =A1&B1&C1&D1&E1) and then sort by that 

column.  If one of the columns contains a date, you will need to convert the date to a 

consistent text format, as done with this formula: 

=A1 & B1 & C1 & TEXT(D1,"yyyymmdd") & E1 



If one of the columns contains numeric values, you can normalize them by using a similar 

TEXT function construct that pads the value with leading zeroes: 

=A1 & TEXT(B1,"000000") & C1 & D1 & E1 

 

Protection 
Protecting a worksheet 

Protecting a worksheet prevents users from making changes to cells, charts, objects, or from 
viewing hidden rows, columns or formulas.  Only the cells or objects marked as locked are 
protected.  This is the default on all cells, but if you change that default a cell or object may be 
edited even when the sheet is protected. 
 
This protection can be removed by the savvy user unless you use a password.  Remember that 
passwords are case sensitive.  If the password is lost, you cannot gain access to any of the 
protected elements on the worksheet, so do not lose the password! 
 
To protect a worksheet: 
1.  Tools, Protection, Protect Sheet… 
2.  In the dialog box, select what you want to protect (the default is all contents, objects and 
scenarios). 
 Contents:  Enforces any protection you applied to individual cells. 
 Objects:  Ensures the user cannot change placement or attributes of any graphics or  
  other objects used in your worksheet. 
 Scenarios:  Protects any scenario definitions you have created. 
3.  Enter a password if desired.  Re-enter the password in the pop-up box. 

 
Protecting a workbook 
Protecting a workbook ensures two things: that the structure (i.e. the worksheets) remains the same 
and that the windows environment remains the same.  When the structure is protected, worksheets can 
not be moved, deleted, hidden, unhidden, or renamed and new worksheets can not be inserted.  When 
the windows environment is protected, the workbook will open in the same size and position each time.   
Please note that protecting a workbook does not protect the sheets in the workbook from changes to 
the cells!!   Similar to protecting a worksheet, a password can be provided with the same stipulations as 
above. 
 

To protect a workbook: 
1.  Tools, Protection, Protect Workbook… 
2.  In the dialog box, select what you want to protect (the default is structure but not windows). 
3.  Enter a password if desired.  Re-enter the password in the pop-up box. 

 
Requiring a password to open a file 
If you want to require a password to open a file this option can also be set independently of the 
protection on the workbook or worksheet.  This can only be done when you are saving the file.  The 
same password rules apply. 
 

To require a password to open a file. 
1.  File, Save As…. 
2.  Rename or name the file (do not close the dialog box!) 



3.  On the dialog box there is a Tools dopdown menu.  Select General Options. 
4.  Enter a password to open and/or a password to modify. 
5.  You may also choose to recommend that the file is opened in read only mode (this does not 
actually make it open in read only mode!) and to create a backup if desired. 

 

 
 

You can save changes to a password-protected workbook without using the password by first 
opening the workbook as read-only.  Make the changes you want in the workbook, and then 
save it with a different name. The workbook saved with a new name does not require a 
password and is available for editing. 

 


